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KATA PENGANTAR 

 

 

Puji syukur saya panjatkan kehadirat allah SWT karena dengan Rahmat dan hidayah-Nya, 

Modul Statistika dan SPSS ini dapat diselesaikan dengan sebaik-baiknya. Modul ini disusun 

untuk menjadi panduan mahasiswa dalam proses belajar mata kuliah Statistika dan SPSS. 

 

Modul ini diharapakan dapat menjadi tambahan referensi bagi mahasiswa dalam melakukan 

pengolahan data hasil penelitian, pemilihan metode analisis data yang sesuai dan dalam 

melakukan interpretasi hasil analisis data menggunakan perangkat lunak statistic SPSS 

(Statistical Product Service and Solution). Topik penggunaan SPSS ini terdapat dalam salah 

satu bahan kajian mata kuliah Statistika dan SPSS pada ilmu administrasi negara dan 

komunikasi Stisipol Candradimuka Palembang 

 

Bahan ajar ini dapat diselesaikan berkat bantuan dan dukungan semua pihak serta pihak lain 

yang tidak dapat disebutkan satu persatu. Oleh karena itu penulis mengucapkan terima kasih 

yang sebesar- besarnya pada semua pihak yang telah membantu terselesaikannya modul ini.. 

 

Semoga modul ini berguna bagi mahasiswa dalam mata kuliah Statistika dan SPSS. Kritik dan 

saran yang membangun sangat diarapkan untuk penyempurnaan bahan ajar ini. 
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BAB I  

STATISTIKA 

1.1 Pengertian statistika 

Kata ”statistik atau statistika” berasal dari bahasa Latin ”status” yang artinya ”negara”. Kata ini 

pertama kali digunakan oleh Aristoteles di dalam bukunya yang terkenal yang berjudul 

”politeia”. Aristoteles, dalam buku tersebut menerangkan mengenai seratus lima puluh negara 

dan keterangannya ini disebutkannya sebagai statistika. Sekarang istilah statistik setidaknya 

dapat ditinjau dari beberapa sudut pengertian. 

Kata statistik dapat diartikan sebagai, pertama: kumpulan angka-angka mengenai sesuatu 

masalah yang memberikan gambaran mengenai masalah tersebut. Kedua: kumpulan data 

berbentuk angka yang dihitung dari sekumpulan data dan menjadi wakil bagi data itu. Ketiga: 

arti statistik yang dikaitkan dengan ilmu pengetahuan atau metode ilmiah dan sering disebut 

Statistika. Oleh karena itu, statistika merupakan metode ilmiah yang mempelajari tentang cara 

mengumpulkan, menyajikan dan menganalisis data yang bersifat kuantitatif sehingga 

menghasilkan keputusan yang rasional. 

1.2.Pemanfaatan Statistika Dalam lapangan sosial 

Statistika merupakan bagian yang tak terpisahkan dari berbagai bidang ilmu termasuk ilmu-

ilmu sosial sehingga muncullah istilah statistika sosial atau yang sehari-hari lazim disebut 

secara singkat sebagai statistik sosial. Istilah statistik sosial yang dipakai dalam modul ini 

diartikan sebagai ilmu pengetahuan (cabang statistika) yang di dalamnya banyak membahas 

tentang prinsip-prinsip, metode, dan prosedur yang digunakan dalam mengumpulkan, 

menganalisis, serta menginterpretasikan sekumpulan data yang berkaitan dengan gejala-gejala 

sosial. Wujudnya bisa merupakan kegiatan mengumpulkan data-data yang berkaitan dengan 

sosial, seperti kegiatan mengolah dan menganalisis data-data sosial keagamaan untuk kemudian 

diinterpretasikan dan direpresentasikan dalam tabel ataupun diagram/grafik yang 

menggambarkan kondisi suatu data statistik komunitas atau masyarakat tertentu. 

Statistik sosial seperti dimaksudkan di atas adalah statistika terapan karena lebih menekankan 

pada penerapan rumus-rumus statistika di bidang sosial. Rumus-rumus statistika dalam hal ini 

tidak dibicarakan bagaimana menyusunnya atau bagaimana terjadinya, melainkan bagaimana 

penerapannya di bidang sosial. Ibarat seorang juru rawat yang menghadapi thermometer, dia 

tidak mempersoalkan bagaimana cara dan dari bahan apa membuat thermometer itu, tetapi dia 

hanya mempersoalkan bagaimana caranya menggunakan thermometer tersebut. 

Demikian juga para mahasiswa dalam menghadapi mata kuliah statistika, mereka cukup 
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memahami bagaimana penerapan statistika di bidang sosial. Tidaklah benar anggapan yang 

menyatakan bahwa untuk mempelajari statistik sosial diperlukan dasar matematika yang kuat. 

Untuk mempelajari statistik sosial cukup diperlukan dasar-dasar matematika yang sederhana 

saja yang telah diperoleh para mahasiswa sewaktu mereka masih di sekolah lanjutan tingkat 

atas. Selebihnya yang diperlukan adalah kesanggupan belajar yang tekun, teratur, teliti, tabah 

dan tidak lekas putus asa. 

Statistika dalam ilmu-ilmu sosial dapat dirasakan manfaatnya apabila dapat menunjang 

kelancaran tugas, misalnya dipakai dalam kegiatan evaluasi (penilaian) dan penelitian. Dalam 

kegiatan evaluasi, statistika menjadi alat bantu untuk menganalisis dan menyimpulkan data 

hasil evaluasi. Sebagai contoh, ketika para dosen mengevaluasi ketercapaian hasil perkuliahan, 

biasanya data yang terkumpul berbentuk data kuantitatif sebelum diinterpretasikan menjadi data 

kualitatif. Pengolahan data kuantitatif tersebut dapat diuji dengan menggunakan statistik 

(ukuran) yang tepat sehingga diperoleh kesimpulan bahwa testee (subjek yang dievaluasi) itu 

berukuran tinggi-rendah, baik-jelek, atau berhasil-gagal. Dalam kegiatan penelitian (sosial), 

statistika banyak dipakai sebagai pendeskripsi data kuantitatif yang terkumpul melalui ukuran 

rata-rata, simpangan baku dan sejenisnya. Selain itu statistika sangat berperan untuk menguji 

keberlakuan suatu hipotesis melalui alur pengujian hipotesis. 

1.3  Macam Statistika 

 

 

 

Ada dua macam statistika yaitu statistika murni dan statistika terapan. Statitika murni 

membicarakan teori-teori dan rumus-rumus secara rinci, sedangkan statistika terapan lebih 

menekankan pembahasannya pada penerapan atau penggunaan rumus-rumus tersebut dalam 

berbagai bidang kehidupan. Sesuai judulnya maka tulisan ini akan membicarakan statistika 

terapan, yaitu statistika yang diterapkan dalam bidang ilmu-ilmu sosial. 

Statistika terapan dibagi menjadi dua bagian, yaitu statistika deskriptif dan statistika inferensial. 

Statistika deskriptif adalah statistika yang tugasnya terbatas hanya menggambarkan atau 

mendeskripsikan data secara apa adanya, sedangkan statistika inferensial adalah statistika yang 
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berhubungan dengan penarikan kesimpulan atau inferensi. 

Dikaitkan dengan konteks penelitian, statistika deskriptif adalah statistik yang digunakan 

untuk menggambarkan atau menganalis suatu statistik hasil penelitian, tetapi tidak digunakan 

untuk membuat kesimpulan yang lebih luas (generalisasi/inferensi). Penelitian yang tidak 

menggunakan sampel, analisisnya akan menggunakan statistika deskriptif. Demikian juga 

penelitian yang dilakukan hanya kepada sampel tetapi peneliti tidak bermaksud untuk membuat 

kesimpulan bagi populasi di mana sampel diambil, maka statistik yang digunakan adalah statistika 

deskiptif. Adapun statistika inferensial adalah statistika yang digunakan untuk menganalisis data 

sampel yang kesimpulannya akan digeneralisasikan (diinferensikan) untuk populasi di mana 

sampel diambil. 

Terdapat dua macam statistika inferensial, yaitu statistika parametris dan nonparametris. 

Statistika parametris terutama digunakan untuk menganalisis data interval dan rasio, yang diambil 

dari populasi yang berdistribusi normal. Sedangkan statistik nonparametris terutama digunakan 

untuk menganalisis data nominal dan ordinal dari suatu populasi yang bebas distribusi. 

 

1.4. Tujuan Statistika  

1. Sebagai sumber bahan atau keterangan mengenai berbagai hal 

2. Mendeskripsikan atau menjelaskan data terkait populasi tertentu 

3. Memperoleh gambaran masalah dari sebuah populasi 

4. Membuat estimasi dari data untuk dijadikan sebagai dasar pengambilan keputusan 

5. Membantu menganalisis data agar dapat mengetahui nilai dari suatu hal 

6. Mengurangi luasnya jumlah populasi ke dalam ukuran yang lebih kecil agar dapat dipahami 

dengan mudah 

 

1.5. Fungsi Statistika 

1. Fungsi deskriptif dengan memberikan keterangan atau penjelasan deskriptif mengenai data 

dari suatu peristiwa yang sebelumnya dikumpulkan melalui berbagai proses penelitian. 

2. Fungsi Inferensial adalah sebagai estimasi atau hipotesis yang kemudian dijadikan landasan 

dalam memprediksi suatu hal berdasar atas data, gejala, serta peristiwa. 
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BAB II 

PENGANTAR SPSS 

 

2.1.Pengertian SPSS 

SPSS dipublikasikan oleh SPSS Inc, merupakan sebuah program komputer yang 

digunakan untuk membuat analisis statistika. SPSS (Statistical Package for the Social Sciences 

atau Paket Statistik untuk Ilmu Sosial) versi pertama dirilis pada tahun 1968, diciptakan oleh 

Norman Nie, seorang lulusan Fakultas Ilmu Politik dari Stanford University, yang sekarang 

menjadi Profesor Peneliti Fakultas Ilmu Politik di Stanford dan Profesor Emeritus Ilmu Politik 

di University of Chicago. Semula SPSS hanya digunakan untuk ilmu social saja, tapi 

perkembangan berikutnya digunakan untuk berbagai disiplin ilmu sehingga kepanjangannya 

berubah menjadi “Statistical Product and Service Solution”. 

SPSS digunakan oleh peneliti pasar, peneliti kesehatan, perusahaan survei, pemerintah, 

peneliti pendidikan, organisasi pemasaran, dan sebagainya. Selain analisis statistika, 

manajemen data (seleksi kasus, penajaman file, pembuatan data turunan) dan dokumentasi data 

(kamus metadata ikut dimasukkan bersama data) juga merupakan fitur-fitur dari software dasar 

SPSS. Keunggulan SPSS adalah: 

1. Diwujudkan dalam menu dan kotak-kotak dialog antarmuka (dialog interface) yang 

cukup memudahkan para user dalam perekaman data (data entry) 

2. Memberikan perintah dan sub-sub perintah analisis hingga menampilkan hasilnya. 

3. Memiliki kehandalan dalam menampilkan chart atau plot hasil analisis 

4. Kemudahan penyuntingan bilamana diperlukan 
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2.2.Menu Bar 

Menu bar berisi kumpulan perintah – perintah dasar untuk mengoperasikan SPSS. 

Menu bar terdiri atas: 

2.2.1. File 

Untuk operasi file dokumen SPSS yang telah dibuat, baik untuk perbaikan pencetakan 

dan sebagainya. Ada 5 macam data yang digunakan dalam SPSS, yaitu : 

2.2.1.1. Data : dokumen SPSS berupa data 

2.2.1.2.Systax : dokumen berisi file syntax SPSS 

2.2.1.3. Output : dokumen yang berisi hasil running out SPSS 

2.2.1.4.Script : dokumen yang berisi running out SPSS 

2.2.1.5. Database 

 

 

Dalam menu FILE, terdapat beberapa operasi perintah yaitu: 

➢ New : membuat lembar kerja baru SPSS 

➢ Open : membuka dokumen SPSS yang telah ada 

Secara umum ada 3 macam ekstensi dalam lembar kerja SPSS, yaitu : 

*.spo : file data yang dihasilkan pada lembar data editor 

*.sav : file text/obyek yang dihasilkan oleh lembar output 

*.cht : file obyek gambar/chart yang dihasilkan oleh chart window 

Kasus (Cases) 

Variabel 

Tool Bar 

Menu Bar 
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➢ Read Text Data : membuka dokumen dari file text (yang berekstensi txt),yang bisa 

dimasukkan/dikonversi dalam lembar data SPSS 

➢ Save : menyimpan dokumen/hasil kerja yang telah dibuat. 

➢ Save As : menyimpan ulang dokumen dengan nama/tempat/type dokumen yang 

berbeda 

➢ Page Setup : mengatur halaman kerja SPSS 

➢ Print : mencetak hasil output/data/syntaq lembar SPSS 

Ada 2 option/pilihan cara mencetak, yaitu : 

- All visible output :mencetak lembar kerja secara keseluruhan 

- Selection : mencetak sesuai keinginan yang kita sorot/blok 

➢ Print Preview : melihat contoh hasil cetakan yang nantinya diperoleh 

➢ Recently used data: berisi list file data yang pernah dibuka sebelumnya. 

➢ Recently used file : berisi list file secara keseluruhan yang pernah dikerjakan 

 

 

2.2.2. Edit 

Untuk melakukan pengeditan pada operasi SPSS baik data, serta pengaturan/option 

untuk konfigurasi SPSS secara keseluruhan. 

➢ Undo : pembatalan perintah yang dilakukan sebelumnya 

➢ Redo : perintah pembatalan perintah redo yang dilakukan sebelumnya 

➢ Cut : penghapusan sebual sel/text/obyek, bisa dicopy untuk keperluan tertentu 

dengan perintah dari menu paste 

➢ Paste : mempilkan sebua sel/text/obyek hasil dari perintah copy atau cut 

➢ Paste after : mengulangi perintah paste sebelumya 

➢ Paste spesial : perintah paste spesial, yaitu bisa konvesri ke gambar, word, dll 

➢ Clear : menghapusan sebuah sel/text/obyek 

➢ Find : mencari suatu text 

➢ Options : mengatur konfigurasi tampilan lembar SPSS secara umum 

 

 

2.2.3. View 

Untuk pengaturan tambilan di layar kerja SPSS, serta mengetahu proses-prose yang 

sedang terjadi pada operasi SPSS. 

➢ Status Bar : mengetahui proses yang sedang berlangsung 

➢ Toolbar : mengatur tampilan toolbar 

➢ Fonts : untuk mengatur jenis, ukuran font pada data editor SPSS 
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Outline size : ukuran font lembar output SPSS 

Outline font : jenis font lembar output SPSS 

➢ Gridlines : mengatur garis sel pada editor SPSS 

➢ Value labels : mengatur tampilan pada editor untuk mengetahui value label 

 

 

2.2.4. Data 

Menu data digunakan untuk melakukan pemrosesan data. 

➢ Define Dates : mendefinisikan sebuah waktu untuk variable yang meliputi jam, 

tanggal, tahun, dan sebagainya 

➢ Insert Variable : menyisipkan kolom variable 

➢ Insert case : menyisipkan baris 

➢ Go to case : memindahkan cursor pada baris tertentu 

➢ Sort case : mengurutkan nilai dari suatu kolom variable 

➢ Transpose : operasi transpose pada sebuah kolom variable menjadi baris 

➢ Merge files : menggabungkan beberapa file dokumen SPSS, yang dilakukan 

dengan penggabungan kolom-kolom variablenya 

➢ Split file : memecahkan file berdasarkan kolom variablenya 

➢ Select case : mengatur sebuah variable berdasarkan sebuah persyaratan tertentu 

 

 

2.2.5. Transform 

Menu transform dipergunakan untuk melakukan perubahan-perubahan atau 

penambahan data. 

➢ Compute : operasi aritmatika dan logika untuk 

➢ Count : untuk mengetahui jumlah sebuah ukuran data tertentu pada suatu baris 

tertentu 

➢ Recode : untuk mengganti nilai pada kolom variable tertentu, sifatnya 

menggantikan (into same variable) atau merubah (into different variable) pada 

variable baru 

➢ Categorize variable : merubah angka rasional menjadi diskrit 

➢ Rank case : mengurutkan nilai data sebuah variabel 

 

 

2.2.6. Analyse 

Menu analyse digunakan untuk melakukan analisis data yang telah kita masukkan ke 

dalam komputer. Menu ini merupakan menu yang terpenting karena semua pemrosesan 
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dan analisis data dilakukan dengan menggunakan menu correlate, compare mens, 

regresion. 

2.2.7. Graph 

Menu graph digunakan untuk membuat grafik, diantaranya ialah bar, line, pie, dll. 

2.2.8. Utilities 

Menu utilities dipergunakan untuk mengetahui informasi variabel, informasi file, dll. 

2.2.9. Ad-ons 

Menu ad-ons digunakan untuk memberikan perintah kepada SPSS jika ingin 

menggunakan aplikasi tambahan, misalnya menggunakan alikasi Amos, SPSS data 

entry, text analysis, dsb. 

2.2.10. Windows 

Menu windows digunakan untuk melakukan perpindahan (switch) dari satu file ke file 

lainnya. 

2.2.11. Help 

Menu help digunakan untuk membantu pengguna dalam memahami perintah-perintah 

SPSS jika menemui kesulitan. 

 

2.3. Tool Bar 

Tool Bar pada SPSS memberikan shortcut perintah berupa ikon yang dapat 

mempercepat pekerjaan terkait beberapa fungsi menu bar pada SPSS. Berikut ilustrasi toolbar 

dari perangkat lunak SPSS. 

Tabel 1.1. Ikon pada Tool Bar dan Fungsinya 
 

Ikon 

Toolbar 
Nama Ikon Fungsi 

 

 

Open data 

document 

Untuk membuka file yang tersimpan, sama dengan 

perintah File › Open › Data 
 

 

Save this 

document 

Untuk menyimpan file yang sedang aktif, sama dengan File › 

Save (Ctrl+S) 
 

 
Print 

Untuk mencetak data yang aktif pada Data View, sama 

dengan Ctrl+P 
 

 

Recall 

recently used 

dialogs 

 

Untuk memanggil dialog perintah yang sering digunakan 

 

 
Undo 

Untuk membatalkan perintah sebelumnya, sama 

dengan Ctrl+Z 
 

 
Redo 

Untuk mengembalikan perintah yang telah dibatalkan 

sebelumnya, sama dengan Ctrl+Y 
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Go to case 

Untuk berpindah atau menyorot suatu kasus yang spesifik, 

sama dengan Edit › Go to Case. 
 

 

Go to 

variable 

Untuk menyorot variable tertentu atau yang spesifik, sama 

dengan Edit › Go to Variable 
 

 
Variable 

Untuk melihat informasi setiap variabel pada lembar kerja 

yang aktif, sama dengan Utilities › Variables. 

 

 

 

Run 

descriptive 

statistics 

Menjalankan fungsi statistika deskriptif, yang secara default 

menampilkan frekuensi data. Variabel yang disorot pada 

lembar kerja aktif akan diproses untuk analisis statistika 

deskriptif. Sama dengan Analyze › Descriptive Statistics › 

Frequencies 

 

 

 

Find 

Berfungsi untuk mencari suatu nilai dari Data View yang aktif 

dan juga tersedia untuk menggantikan nilai tersebut. Shortcut 

ini merupakan perintah dari Find (Ctrl+F) dan Replace 

(Ctrl+H) pada menu Edit 
 

 
Insert cases 

Untuk menambah kasus baru di sel yang disorot, sama 

dengan Edit › Insert Variable 
 

 

Insert 

variable 

Untuk menambah atau menyisipkan variabel baru, sama 

dengan Edit › Insert Variable 
 

 

 

Split file 

Untuk memecah dataset berdasarkan variabel. Hal ini dapat 

mempermudah analisis khusus terhadap variabel tertentu. 

Sama dengan Data › Split File 
 

 
Weight cases 

Untuk menentukan bobot variabel, sama dengan Data › 

Weight Cases 
 

 
Select cases 

Untuk menyorot kasus yang spesifik, sama dengan Data › 

Select Cases 
 

 
Value labels 

Untuk mengganti tampilan value atau label pada Data View, 

hal ini berkaitan dengan ordinal dan nominal measurement 
 

 

Use variable 

sets 

Untuk memilih variabel yang akan digunakan untuk analisis 

data secara menyeluruh, sama dengan Utilities › Use 

Variable Sets 
 

 

Show all 

variables 

Untuk menampilkan semua variabel, sama dengan Utilities › 

Show All Variables 
 

 
Spell check 

Untuk mengecek kesalahan eja, bergantung konfigurasi 

bahasa yang aktif, sama dengan Utilities › Spelling 

 

2.4. Data View 

Data view adalah tampilan lembar kerja SPSS yang menampilkan variabel beserta data 

yang ada dalam variabel tersebut. Data view pada SPSS menampilkan setiap baris sebagai suatu 

kasus (case) dan setiap kolom merepresentasikan suatu variabel. 

Bagian-bagian Data View (Lihat Gambar 1). 
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2.4.1. Kasus (cases) pada SPSS merepresentasikan suatu hasil pengamatan terhadap 

suatu objek dapat berupa pengamatan berdasarkan observasi atau eksperimen. 

Contoh: hasil survey suatu penelitian, hasil pendataan data mahasiswa, dan lain-

lain. 

2.4.2. Variabel adalah atribut, karakteristik, atau pengukuran yang mendeskripsikan 

suatu kasus (case). Contoh: umur, nama, pendidikan, dan lain-lain. 

 

2.5. Variabel View 

Variable view adalah tampilan lembar kerja SPSS untuk melakukan manajemen 

variabel terkait membuat dan mengedit variabel. Seluruh variabel pada SPSS dapat dilihat 

melalui variable view. Terdapat opsi name, type (tipe variabel), width, decimals, label, values, 

missing, columns, align, measure, dan role pada variabel view. Berikut penjelasan masing- 

masing opsi tersebut: 

 

Tabel 1.2. Opsi pada Variabel View 
 

Kolom Opsi Penjelasan 

Name Memberikan nama variabel, akan ditampilkan pada header Data View 

 

 

 

 

 

 

Type 

Menentukan tipe variabel 

Numeric Data angka (default) 

Comma Data angka dengan pemisah . 

Dot Data angka dengan pemisah , 

Scientific Notation Data angka dengan tampilan notasi matematika 

Date Data tanggal 

Dollar Data angka dengan tampilan dollar 

Custom Currency Data angka dengan tampilan mata uang tertentu 

String Data teks 

Restricted Numeric 
Hanya data angka diawali dengan angka 0 sesuai 

panjangnya 

Width Menentukan panjang data 

Decimals Menentukan panjang data desimal secara numerik 

Label Memberikan label yang akan ditampilkan pada jendela output 

Values 
Umumnya digunakan oleh data nominal dan ordinal untuk merepresentasikan 

suatu nilai numerik sebagai label 

Missing Untuk penanganan data yang tidak ada (anda dapat membiarkan kosong) 

Column Menentukan panjang tampilan data pada Data View 

Menentukan align tampilan data 
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Align 
Left Rata kiri 

 Right Rata kanan (default) 

Center Rata tengah 

 

 

Measure 

Menentukan tipe data 

Nominal Data nominal 

Ordinal Data tingkatan 

Scale Data skala (default) 

 

 

 

 

Role 

Digunakan untuk menentukan peranan variabel dalam melakukan analisis data 

Input Variabel independent (predictor/default) 

Target Variabel dependent (output) 

None Tanpa peranan 

Partition 
Variabel akan dilakukan partisi data menjadi sampel 

terpisah 

Split 
Digunakan dengan IBM® SPSS® Modeler (bukan 

IBM® SPSS® Statistics) 

 

 

 

Rangkuman 

✓ SPSS (Statistical Product and Service Solution) merupakan sebuah program komputer 

yang digunakan untuk membuat analisis statistika. 

✓ Menu bar berisi kumpulan perintah – perintah dasar untuk mengoperasikan SPSS. 

✓ Toolbar pada SPSS memberikan shortcut perintah berupa ikon yang dapat mempercepat 

pekerjaan terkait beberapa fungsi menu bar pada SPSS. 

✓ Data view adalah tampilan lembar kerja SPSS yang menampilkan variabel beserta data 

suatu variabel. 

✓ Variable view adalah tampilan lembar kerja SPSS untuk melakukan manajemen variabel 

terkait membuat dan mengedit variabel. 

 

Evaluasi Formatif 

1. Jelaskan apa saja kegunaan SPSS ! 

2. Jelaskan fungsi 5 menu yang ada pada Menu Bar SPSS ! 

3. Jelaskan fungsi 5 menu yang ada pada Tool Bar SPSS ! 

4. Apa perbedaan mendasar antara Variabel View dan Data View? 
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BAB III 

DATA 

 

3.1.Jenis Data 

Data berasal dari datum berarti materi atau kumpulan fakta untuk keperluan analisa, 

diskusi, presentasi ilmiah atau tes statistik. Data merupakan bahan mentah yang perlu diproses 

untuk menjadi informasi, sedangkan informasi dapat segera dipakai untuk pengambilan 

keputusan. Jenis data, secara umum dibedakan menjadi 4 macam, yaitu: 

1. Nominal 

Data nominal merupakan level data paling sederhana. Penyusunan data nominal tidak 

didasarkan pada urutan nilai atau angka yang digunakan sebagai kode. Nilai atau angka 

tersebut murni hanya untuk memberi tanda pada objek saja. Hal ini yang menyebabkan 

data nominal atau skala nominal disebut sebagai skala pengukuran data statistik paling 

sederhana jika dibandingkan tiga jenis data lainnya. 

Contoh : Jenis kelamin, Suku, Agama, Status Pernikahan. 

2. Ordinal 

Data ordinal merupakan data yang memiliki level skala pengukurannya satu tingkat 

lebih tinggi dibanding data nominal. Jika dalam data nominal semua anggota set yang 

menjadi objek memiliki tingkat setara, maka data ordinal menyajikan data berupa 

klasifikasi berdasarkan tingkatan atau kedudukan objek penelitian. Ciri khas dari data 

ordinal adalah penyajian datanya diurutkan dengan daftar urutan yang logis, misalnya 

dari tinggi ke rendah, atau sebaliknya. 

Contoh: Tingkat pendidikan SD diwakili angka 1, SMP diwakili angka 2, SMA diwakili 

angka 3. Hal tersebut menunjukan tingkatan atau kedudukan pendidikan dimana 

pendidikan tertinggi adalah SMA dan pedidikan terendah adalah SD. 

3. Interval 

Dalam ilmu statistika, data interval memiliki tingkat pengukuran lebih tinggi dari data 

nominal dan data ordinal. Data interval merupakan data yang objeknya dapat diurutkan 

dengan memiliki perbedaan yang sama. Data interval termasuk dari bagian data 

kontinu. Dalam data interval, data tidak memiliki nilai nol mutlak, artinya jika atribut 

tersebut memiliki nilai nol maka atribut itu ada nilainya. 

Contoh: Jika suhu bernilai 0 derajat celcius bukan berarti tidak ada suhunya, akan tetapi 

suhu bernilai 0 derajat berarti lebih rendah dari 1 derajat celcius. 
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4. Rasio 

Data rasio merupakan data yang terurut dengan selisih yang sama di setiap datanya. 

Hampir sama dengan data interval, data rasio juga merupakan bagian dari data kontinu. 

Namun perbedaannya jika pada data interval tidak memiliki nilai mutlak maka pada 

data rasio memiliki nilai mutlak. 

Contoh: data yang memiliki nilai mutlak adalah data tinggi badan dan berat badan. Nilai 

nol dalam berat badan dan tinggi badan berarti benda atau barang tersebut tidak 

memiliki berat dan tinggi. 

 

Tabel 2.1. Perbedaan Jenis Data 
 

Sifat Skala Nominal Ordinal Interval Rasio 

Membedakan obyek atas 

kelompok/kategori 
√ √ √ √ 

Dapat ditentukan urutan 

kelompok/bertingkat 
X √ √ √ 

Dapat ditentukan jarak/beda 

antar kelompok 
X X √ √ 

Dapat dibandingkan antar 

kelompok (adanya titik nol 

mutlak) 

 

X 

 

X 

 

X 

 

√ 

 

3.2 Kategori Data pada SPSS 

Measure adalah sebutan tipe variabel yang terdapat pada SPSS. Terdapat 3 tipe variabel 

pada SPSS yaitu scale, nominal, dan ordinal. Ketiga tipe variabel tersebut memberikan jenis 

nilai serta informasi analisis yang berbeda. Penentuan measure adalah hal dasar yang sangat 

penting untuk diketahui saat menggunakan SPSS. Misalnya kita tidak boleh membuat variabel 

nominal untuk melakukan perhitungan nilai rata-rata dan standar deviasi. 

Tabel 2.2. Jenis Data pada SPSS 
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5. Variabel Nominal pada SPSS 

Variabel nominal adalah tipe variabel yang merepresentasikan suatu nilai numerik 

sebagai label dari variabel tersebut. Variabel nominal tidak digunakan untuk melakukan 

perhitungan data secara matematika seperti penjumlahan, pengurangan, dan lain 

sebagainya. Secara fundamental variabel jenis ini digunakan untuk menghitung 

banyaknya data. Hal ini sangat mempengaruhi analisis data tingkat lanjut. Beberapa 

contoh penggunaan nominal level saat membuat variabel dengan menggunakan SPSS 

adalah sebagai berikut: 

➢ Variabel jenis kelamin 

➢ Variabel nama perusahaan 

➢ Variabel nama kabupaten 

 

 

6. Variabel Ordinal pada SPSS 

Variabel ordinal adalah tipe variabel yang sering disebut sebagai ranked data atau data 

dengan peringkat. Data dalam bentuk ordinal level dikategorikan berdasarkan kuantitas 

dan kualitasnya. Beberapa contoh penggunaan ordinal level adalah sebagai berikut: 

➢ Variabel tingkatan pendidikan (TK, SD, SMP, SMA, dan PT) 

➢ Variabel tingkat umur (balita, anak-anak, remaja, dewasa, dan manula) 

➢ Variabel tingkat suhu (dingin, hangat, dan panas) 

 

 

7. Variabel Scale pada SPSS 

Variabel scale adalah tipe variabel yang digunakan untuk melakukan perhitungan data 

terhadap variabel angka seperti menghitung nilai statistika deskriptif. SPSS secara 

fundamental akan mendefinisikan data secara otomatis sebagai variabel dengan tingkat 

interval atau tingkat rasio. SPSS tidak mengharuskan pengguna membedakan data scale 

secara manual, apakah termasuk data dengan tingkat interval atau tingkat rasio. 

Beberapa contoh penggunaan variabel scale adalah sebagai berikut, 

➢ Variabel tinggi badan 

➢ Variabel nilai suatu ujian 

➢ Variabel berat badan 
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2.2. Input Data 

Berikut adalah langkah-langkah dalam melakukan proses input data: 

1. Klik Start Program SPSS for Windows. Pada menu SPSS akan muncul jendela sebagai 

berikut: 

 
 

 

2. Untuk membuka data set yang baru, klik New Dataset kemudian klik OK. Layar akan 

terbuka “Untitled 1- IBM SPSS Statistics Data Editor” seperti pada gambar berikut: 

 

Selanjutnya disebut sebagai Jendela Data Editor. Karena belum ada data, tampilannya 

masih kosong. 
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3. Langkah selanjutnya adalah membuat variabel, caranya pada bagian bawah layar klik 

Variabel View. 
 

 

Contoh membuat variabel : 

➢ Pada kolom Name ketik nama variabel masing-masing (tidak bisa menggunakan 

spasi). 

➢ Pada Type karena nama merupakan karakter atau huruf maka klik String, untuk 

vairabel lain seperti umur yang berupa angka maka masukan numeric. 

➢ Width ditentukan berdasarkan banyaknya huruf atau angka maksimal yang ingin 

dimasukkan. 

➢ Pada variabel nama, karena tidak menggunakan desimal, maka kolom Decimals 

diisi 0. Jika variabel lain menggunakan desimal, maka dapat diisi sesuai jumlah 

desimal pada variabel tersebut. 

➢ Untuk variabel nama, pada kolom Label isi nama responden, untuk variabel lain 

menyesuaikan tiap variabel. Karena nama responden adalah unik maka lewat saja 

kolom Values (none). Untuk variabel Jenis_Komputer, karena terdiri dari 2 jenis 

maka ditulis 1 untuk CRT, 2 untuk LCD. 
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➢ Karena tidak ada missing maka dibiarkan kolom Missing 

➢ Kolom Columns berfungsi menentukan lebar kolom pada data view isi 8. 

➢ Untuk keseragaman Align dipilih left (rata kiri) untuk karakter atau huruf, dan right 

untuk numeric. 

➢ Pada variabel nama, measure diisi nominal, untuk variabel lain menyesuaikan 

dengan jenis datanya (Lihat materi 2.2. Kategori Data pada SPSS) 

➢ Role pilih input karena variabel dependen, pada variabel lain menyesuaikan (Lihat 

materi 1.5. Variabel View). 

 

4. Langkah selanjutnya adalah memasukan data (input data) , caranya pada bagian bawah 

layar klik Data View. 

 
 

 

Cara mengisi data 

➢ Pada variabel nama, masukan nama responden. 

➢ Pada variabel umur, masukan umur responden. 

➢ Pada variabel lama, masukan lama kerja responden. 

➢ Pada variabel penerangan, masukan hasil pengukuran penerangan tiap responden. 

➢ Pada variabel jenis_komputer, masukan kode angka sesuai dengan kode yang diisi 

di Variabel View bagian values. Hal ini karena ada 2 jenis data, sehingga untuk 

memudahkan menggunakan kode, misal 1 untuk layar CRT, 2 untuk layar LCD. 

Untuk data kategorik lain seperti jenis kelamin, tingkat pendidikan juga dapat 

menggunakan langkan ini untuk memudahkan dalam input data. 
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➢ Pada variabel hasil_RT, masukan hasil pengukuran reaction timer responden. 

➢ Jika pengisian diatas benar maka akan menghasilkan data seperti pada gambar 

diatas. 

 

5. Menyimpan data 

Untuk penyimpanan data yang pertama klik menu File, pilih Save As, maka akan 

muncul kotak dialog Save as pada ruang File Name untuk keseragaman masukan 

Latihan SPSS 1, untuk Type Data pakai ekstensi sav. Apabila tidak memerlukan nama 

baru dalam penyimpanan file, pada menu file langsung klik sub menu Save. 

 
 

 

6. Jendela SPSS Output 

Walaupun tidak muncul pada saat pertama kali menjalankan program SPSS, ada jendela 

lain yang terbuka tetapi belum aktif yaitu jendela Output IBM SPSS Statistics Viewer 

(Selanjutnya disebut Jendela Output). Jendela output akan menampilkan hasil-hasil 

analisis statistik dan grafik yang anda buat. Sebagai contoh pada gambar berikut 

ditampilkan Jendela Output: 
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7. Menyimpan Output 

Output seperti hasil analisis, grafik, tabel perlu disimpan. Untuk menyimpannya, pada 

jendela output klik File, kemudian Save As. Pilih lokasi untuk menyimpan, dan 

masukan nama misal Output Latihan SPSS 1, lalu klik Save. 

 
 

 

3.3 Transformasi Data 

Transformasi data adalah upaya yang dilakukan dengan tujuan untuk mengubah skala 

pengukuran data asli menjadi bentuk lain sehingga data dapat memenuhi asumsi-asumsi yang 

mendasari analisis ragam. Transformasi digunakan untuk merubah bentuk data,misalnya 

merubah data numerik menjadi data kategorik atau merubah dari beberapa variabel yang sudah 

ada dibuat satu variabel komposit yang baru. Langkah transformasi data adalah sebagai berikut: 

 

➢ Pada menu bar klik Transform 

➢ Pilih recode into different variables, hal ini agar data awal tetap bisa muncul di 

data view. Jika kita memilih recode into same variables, maka data awal akan 
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berubah menjadi data tranform. Namun, jika kita memilih recode into different 

variables, baik data awal maupun data transform akan tetap terlihat di data view. 

➢ Setelah muncul kotak dialog, pindahkan variabel yang akan ditransformasi (misal 

umur) ke kotak numerik variable → Output variable. Pada output variables, isi 

nama variabel baru (misal umur2, nama harus berbeda dengan variabel awal), 

isikan juga labelnya. Klik Change kemudian klik old and new values. 

 

➢ Pada kotak dialog, isikan variabel baru beserta kodenya. Misal untuk umur jika 

dikategorikan menjadi 1 jika berusia lebih dari 40 tahun, 2 jika 40 tahun ke bawah. 

Maka pada range, value through highest isi dengan 41 (karena kategorinya adalah 

> 40 atau usia 41 tahun ke atas) dan new value isi dengan kode 1, klik Add. Lakukan 

pula untuk kategori kedua yaitu pada range lowest through value isi dengan angka 

40 dan pada new value isi dengan kode 2. Klik Add kemudian Continue dan OK. 
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➢ Tampilan data akan menjadi seperti berikut 
 

➢ Langkah selanjutnya adalah mengubah value dari variabel yang sudah dilakukan 

tranformasi. Klik variabel view, kemudian pada variabel baru (misal Umur2/Umur 

kategorik), klik value kemudian isikan value. Ingat, value diisi pada variabel hasil 

transform, bukan pada variabel awal. Masukan value dengan kode dan label dengan 

kategori atau kriterianya. Misal value 1 label > 40 tahun klik add, value 2 label ≤ 

40 tahun klik add. Kemudian klik OK. 
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➢ Jika melihat data di Data View, tampilan data akan seperti ini. Lakukan pula untuk 

variabel lainnya 

 
 

 

Rangkuman 

✓ Data berasal dari datum berarti materi atau kumpulan fakta untuk keperluan analisa, 

diskusi, presentasi ilmiah atau tes statistik. 

✓ Secara umum, jenis data dikelompokan dalam empat kategori yaitu Nominal, Ordinal, 

Interval dan Rasio. 

✓ Pada SPSS, jenis data dikategorikan menjadi tiga yaitu Nominal, Ordinal dan Scale 

(interval dan rasio). 

✓ Penginputan data adalah proses pemindahan data dari fisik menjadi digital yang dimana 

data tersebut akan diketik dan dimasukkan ke dalam komputer, dalam hal ini adalah ke 

dalam program SPSS. 

✓ Transformasi data adalah upaya yang dilakukan dengan tujuan untuk mengubah skala 

pengukuran data asli menjadi bentuk lain sehingga data dapat memenuhi asumsi-asumsi 

yang mendasari analisis ragam. 
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Evaluasi Formatif 

 

LATIHAN SPSS 1 – INPUT DATA 

Berikut ini adalah data dari suatu penelitian tentang Faktor yang Mempengaruhi Kelelahan 

Kerja pada Operator Perusahaan. Input data berikut dalam SPSS! 

 

 

No 

 

Nama 

 

Umur 

Lama 

Penggunaan 
Komputer 

(jam) 

Frekuensi 

Istrirahat 
per 2 jam 

(menit) 

 

Intensitas 

Penerangan 
(lux) 

 

Jeni 

Layar 
Komputer 

Hasil 

reaction 
timer (mili 

detik) 

1 Tika 24 4 15 320 LCD 190 

2 Keke 32 4 20 400 LCD 200 

3 Yuni 50 5 5 280 CRT 270 

4 Jeny 22 3 10 320 CRT 260 

5 Beni 42 6 5 280 CRT 300 

6 Hapsari 31 6 10 450 LCD 280 

7 Dewi 28 7 20 450 LCD 220 

8 Bella 27 5 20 320 LCD 250 

9 Loli 32 4 10 400 LCD 210 

10 Weni 34 3 15 480 LCD 200 

11 Sinta 42 2 5 400 LCD 200 

12 Siti 41 1 5 320 LCD 220 

13 Akhmad 40 8 10 480 CRT 240 

14 Reza 33 7 10 400 CRT 300 

15 Roni 37 7 5 275 CRT 310 

16 Toni 33 7 10 275 LCD 280 

17 Tata 32 4 15 400 LCD 200 

18 Doni 31 2 15 350 LCD 190 

19 Claudia 30 3 15 350 CRT 210 

20 Rendy 29 5 15 400 CRT 250 

21 Tendi 30 8 10 250 CRT 270 

22 Beno 36 3 20 380 LCD 230 

23 Lulu 22 6 20 250 LCD 290 

24 Heni 35 3 10 310 LCD 210 

25 Sella 29 2 5 250 CRT 270 

26 Maryam 35 7 10 350 CRT 270 

27 Heru 32 7 5 280 CRT 300 

28 Fahmi 31 5 10 400 LCD 240 

29 Jono 30 3 10 320 LCD 240 

30 Indra 33 2 5 320 LCD 210 

31 Dendi 21 6 15 280 CRT 290 

32 Akbar 27 3 15 300 CRT 240 

33 Seto 38 3 10 280 CRT 280 

34 Wido 45 5 15 350 LCD 240 

35 Hasbi 32 8 20 400 LCD 240 
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LATIHAN SPSS 2 – TRANSFORMASI DATA 

 

Data pada latihan SPSS 1 akan dianalisis menggunakan uji chi square yang mengharuskan data 

berupa kategorik. Dari data yang tersedia pada latihan SPSS 1, lakukan tranformasi data dari 

skala numerik menjadi kategorik untuk variabel berikut: 
 

Variabel Kode Transformasi Data 

Umur 1. > 40 tahun 

2. < =40 tahun 

Lama penggunaan komputer 1. > 4 jam 

2. <= 4 jam 

Frekuensi istirahat 1. < 15 menit 

2. >= 15 menit 

Intensitas penerangan 1. < 300 lux 

2. > = 300 lux 

Hasil reaction time (kelelahan mata) 1. Lelah > 240 mili detik 

2. Tdk lelah <= 240 mili detik 
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BAB IV 

STATISTIK DESKRIPTIF 

PENGUKURAN PEMUSATAN DATA 

 

4.1 Pengertian Statistik Deskriptif 

Statistik deskriptif adalah statistik yang berfungsi mendeskripsikan atau memberi 

gambaran terhadap obyek yang diteliti tanpa melakukan analisis dan membuat kesimpulan 

yang berlaku untuk umum (generalisasi). Fungsi dari statistik deskriptif adalah memberikan 

gambaran atau deskripsi suatu data yang dilihat dari frekuensi, central tendency (mean, median, 

mode), standar deviasi, varian, range, minimum, maksimum, kurtosis dan skewness. 

➢ Frekuensi, menunjukkan berapa kali nilai ditemukan. 

➢ Mean, menghitung rata-rata numerik dari sekumpulan nilai. 

➢ Median, mendapatkan titik tengah dari sekumpulan angka yang tersusun dalam urutan 

numerik. 

➢ Mode, metode untuk menemukan nilai yang paling sering muncul dalam kumpulan data. 

➢ Standar Deviasi, menunjukkan sedekat apa semua angka dengan mean. 

➢ Varian, ukuran statistik tentang seberapa tersebar titik-titik data dalam sampel atau 

kumpulan data 

➢ Range, menunjukkan nilai tertinggi dan terendah. 

➢ Keruncingan atau kurtosis adalah tingkat kepuncakan dari sebuah distribusi yang 

biasanya diambil secararelatif terhadap suatu distribusi normal. 

➢ Skewness, menunjukkan kesimetrisan rentang angka dengan mengelompok menjadi 

bentuk kurva. Bisa berada di tengah grafik, condong ke kiri atau kanan. 

 

Pengertian Tendensi Sentral (ukuran pemusatan) adalah nilai tunggal dari data yang dapat 

memberikan gambaran yang lebih jelas dan singkat tentang kecenderungan sekelompok data 

yang juga menjadi wakil bagi seluruh data. Ada beberapa macam ukuran pemusatan yang akan 

dipelajari dalam modul ini, antara lain nilai rata-rata hitung (mean), median dan modus. 

 

4.2. Nilai Rata-Rata (MEAN) 

 

Nilai rata-rata dilambangkan dengan Simbol  (baca: X bar untuk data yang bersumber dari 

sampel) dan    (baca: mu; untuk data yang bersumber dari populasi). Nilai rata-rata dari data 

tunggal dapat diperoleh dengan cara menjumlahkan seluruh nilai data dan membaginya dengan 
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banyak data, sehingga rumusnya dapat dituliskan sebagai berikut: 

   

Rumus ini digunakan untuk nilai-nilai data yang tidak berfrekuensi. Jika nilai-nilai data 

berfrekuensi (memiliki frekuensi kemunculan lebih dari satu kali) maka dapat digunakan 

rumus sebagai berikut: 

 

Untuk menggunakan rumus di atas, sebaiknya disiapkan dulu daftar distribusi frekuensi seperti 

contoh berikut: 

 

Dengan demikian dapat diketahui bahwa nilai rata-rata data tersebut berdasarkan rumus di 

atas adalah: 

 

4.3. Modus 

Modus digunakan untuk menunjukkan gejala-gejala yang sering terjadi, sering dilambangkan 

dengan Mo dan umumnya dipakai sebagai barometer ’nilai rata-rata bagi data kualitatif. Adapun 

untuk data kuantitatif, modus ditentukan dengan melihat frekuensi kemunculan data yang 

terbanyak (tertinggi). Misalnya: gejala A ada 5, gejala B ada 11, gejala C ada 19 dan gejala D ada 

17. Gejala dengan frekuensi tertinggi adalah gejala C, maka dikatakan modusnya adalah C atau 

ditulis Mo = gejala C. Contoh lain misalnya: 

 

Nilai Data ( i ) Frekuensi ( fi ) fi  i 
10 1 10 
9 2 18 
8 3 24 
7 7 49 
6 4 24 
5 2 10 
4 1 4 

Jumlah 20 139 
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 i f i 
10 1 
9 2 

 i f i 

8 3 

7 7 

6 4 

5 2 

4 1 

N 20 

 

Karena data dengan frekuensi tertinggi adalah 7 maka dikatakan modusnya adalah 7. 

 

 
Data f i 

61 – 65 4 
66 – 70 9 
71 – 75 11 
76 – 80 2 
81 – 85 4 
86 – 90 7 
91 – 95 3 

Jumlah 40 

 

 

Selanjutnya jika data disusun secara terkelompok karena jumlah data yang  cukup  besar,  maka  

Mo  dapat  dicari dengan  rumus  sbb: 

 

 
 

4.4. Median 

Median adalah nilai data yang terletak di tengah-tengah setelah data itu disusun menurut urutan 

nilainya sehingga membagi data menjadi dua bagian sama besar dan dapat dilambangkan 
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dengan symbol Me. Jika jumlah data ganjil maka Me merupakan nilai data yang terletak di 

tengah-tengah dimana sebelah kiri dan kanan terdapat n buah data. Contoh: 2, 3, 7, 9, 12. Maka 

Me = 7 dan di sebelah kiri serta kanan terdapat dua buah data. Tetap jika jumlah data genap 

maka Me diambil dari rata-rata hitung dua data paling tengah, misalnya: 5, 7, 10, 15, 17, 23. 

 

Median data berkelompok 

Dibuat pengelompokkan nilai berdasarkan urutan nilai terkecil. 

 

Contoh penyelesaian median untuk data berkelompok 

 

Nilai Ujian Frekuensi 

31-40 1 

41-50 2 

51-60 5 

61-70 15 
71-80 25 

81-90 20 

91-100 12 

Jumlah 80 

 

Setengah jumlah data yang dijadikan median adalah1/2 x 80 = 40. 
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4.5.  Analisis Deskriptif dengan SPSS 

Untuk melakukan analisis deskriptif dengan SPSS, langkahnya sebagai berikut: 

4.1.1 Buka file yang akan dilakukan analisis data, misal file latihan SPSS 2 

4.1.2 Klik analyze > Descriptive statistics > Frequencies 
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4.1.3 Akan muncul kotak dialog frequencies. Lalu masukan variabel yang akan 

dianalisis secara deskriptif, klik statisics. 

 

4.1.4 Akan muncul kotak dialog frequencies statistics, beri tanda ceklis pada 

parameter yang akan digunakan, misal mean, median, standar deviasi, dsb 

 

4.1.5 Klik continue > OK 
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4.1.6 Akan muncul jendela output sebagai berikut: 
 

 

Rangkuman 

✓ Statistik deskriptif adalah statistik yang berfungsi mendeskripsikan atau memberi gambaran 

terhadap obyek yang diteliti tanpa melakukan analisis dan membuat kesimpulan yang 

berlaku untuk umum (generalisasi). 

✓ Fungsi dari statistik deskriptif adalah memberikan gambaran atau deskripsi suatu data yang 

dilihat dari frekuensi, central tendency (mean, median, mode), standar deviasi, varian, 

range, minimum, maksimum, kurtosis dan skewness. 

 

Evaluasi Formatif 

LATIHAN SPSS 3 – ANALISIS DESKRIPTIF 

1. Buka file latihan SPSS 2, lakukan analisis deskriptif pada setiap variabel yang ada! 

2. Interpretasikan hasil dari analisis tersebut! 
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BAB V  

FRAKTIL 

5.1 Pengertian Fraktil 

Fraktil  adalah  nilai-nilai  yang  membagi  seperangkat  data yang  telah  terurut  menjadi 

beberapa bagian yang sama. Fraktil tersebut dapat berupa, Kuartil, Desil, Persentil. 

5.2. Kuartil ( Qn ) 

Nilai kuartil adalah merupakan nilai dari sekumpulan data yang dibagi menjadi empat bagian  

yang  sama,  dan  yang  membagi  data  tersebut  dinamakan  kuartil.  Ada  tiga buahkuartil  

yaitu  :  kuartil  bawah  (  Q1  ),  kuartil  tengah  (  Q2   )  dan  kuartil  atas  (  Q3  ).  

Untukmenentukan nilai-nilai kuartil tersebut dibagi menjadi dua kategori, yaitu nilai-nilai 

kuartilyang belum dikelompokkan ke dalam daftar distribusi frekuensi dan nilai-nilai kuartil 

yangsudah  dikelompokkan  ke dalam  daftar distribusi  frekuensi.  Adapun  urutan  

menentukan nilai-nilai kuartil antara lain sebagai berikut: 

 

 

Kuartil Data Berkelompok 
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Nilai 

Ujian 

Frekuensi 

31-40 1 

41-50 2 

51-60 5 

61-70 15 

71-80 25 

81-90 20 

91-100 12 

Jumlah 80 

 

 

 

5.3. Desil (Dn) 

Desil  adalah  nilai  dari  sekumpulan  data  yang  dibagi  menjadi  sepuluh  bagian  yangsama,  dan  

yang  membagi  data  tersebut  dinamakan  Desil.  Ada  sembilan  buah  desil  yaitu D1, D2,  D3, D4,  

...................D9. Adapun untuk menentukan nilai hasil desil tersebut antara lain : 

Untuk data yang belum dikelompokkan (data tunggal) 

a. Susun berdasarkan urutan data dimulai dari data terkecil hingga terbesar 

b. Tentukan letak desil yang diminta 

c. Tentukan nilai dari desil yang diminta tersebut 
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Desil data Tunggal 

 

Desil data berkelompok 

 

 

Berikut contoh soal menggunakan desil berkelompok : 
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BAB VI 

STATISTIKA INFERENSIA 

 

6.1 Pengertian Statistik Inferensia 

Statistik inferensial yaitu metode yang berhubungan dengan analisis data pada sampel 

dan hasilnya digunakan untuk generalisasi terhadap populasi. Penggunaan statistik inferensial 

didasarkan pada peluang (probability) dan sampel yang dianalisi diperoleh secara acak 

(random). Tugas dari statitika inferensial adalah melakukan estimasi, menguji hipotesis, dan 

mengambil keputusan. Kegiatan penting yang terkait dengan proses inferensi adalah uji beda 

data uji hubungan antara dua variabel data; metode yang sering ditemui adalah uji-t, pembuatan 

model regresi, anova dan statistik parametrik maupun non parametrik. 

 

Statistik inferensia digolongkan menjadi: 

1. Statistik parametrik 

Penggunaan teknik statistik parametrik didasarkan pada didasarkan pada asumsi bahwa 

data yang diambil mempunyai distribusi normal dan jenis data yang digunakan interval 

atau rasio. 

2. Statistika nonparametrik 

Penggunaan statistika nonparametrik tidak megharuskan data yang diambil mempunyai 

distribusi normal dan jenis data yang digunakan dapat nominal dan ordinal. 

 

Pada dasarnya, baik statistik parametrik maupun nonparametrik dapat digunakan untuk analisis 

statistik yang bersifat: 

1. Korelatif 

Teknik analisis korelatif digunakan untuk mengetahui hubungan atau korelasi dari 

sebuah variabel yang lain. Misalnya variabel X dan variabel Y. Teknik analisis yang 

sering dipakai adalah korelasi Pearson dan regresi. 

2. Komparatif 

Teknik analisis komparatif digunakan untuk mengetahui perbedaan nilai rata-rata dari 

suatu kelompok dengan kelompok lainya. Misalnya perbedaan kecemasan antara 

kelompok pria dan wanita, serta perbedaan motivasi kerja antara bagian produksi, 

pemasaran, dan keungan. Teknik analisis yangsering digunakan adalah T-test dan 

anova. 
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6.2 Uji Normalitas 

Uji Normalitas adalah sebuah uji yang dilakukan dengan tujuan untuk menilai sebaran 

data pada sebuah kelompok data atau variabel. Normalitas data sering kali disertakan dalam 

suatu analisis statistika inferensial untuk asatu atau lebih kelompok sampel. Normalitas sebaran 

data menjadi sebuah asumsi yang menjadi syarat untuk menentukan jenis statistik apa yang 

dipakai dalam penganalisa selanjutnya. 

Tabel 4.1. Parameter Normalitas Data 
 

Parameter Kriteria Normal 

Koefisien varians 

= (Standar deviasi/ Mean) x 100% 

< 30 % 

Rasio Skewness 

= Skewness/ Standar error of skewness 

-2 s/d 2 

Rasio Kurtosis 

= Kurtosis/ Standar error of kurtosis 

-2 s/d 2 

Histogram ** Simetris, tidak miring ke kiri atau ke kanan, 

tidak terlalu tinggi atau terlalu rendah 

Box Plot ** Simetris, median tepat di tengah, tidak ada 

outlier (o) atau nilai ekstrim (tanda *) 

Normal Q-Q Plots ** Data menyebar sekitar garis 

Detrendend Q-Q Plots ** Data menyebar sekitar garis pada nilai 0 

Kolmogorov –Smirnov 

Shapiro-Wilk 

p > 0,05 

 

Hasil uji normalitas dapat dinilai secara deskriptif maupun analitik. Pada tabel di atas, 

warna hitam menunjukkan penilaian secara deskriptif, warna biru penilaian secara analitik. 

Tanda ** menunjukkan bahwa dalam menginterpretasikan histogram atau plots, beberapa 

pengamat mungkin mempunyai interpretasi yang berbeda sehingga kesimpulannya bisa 

bebeda. Untuk kesepakatan, metode yang akan digunakan untuk menilai hasil uji normalitas 

adalah secara analitik, dengan pertimbangan: 

a. Penilaian secara analitik (uji Kolmogorof-Smirnov maupun Shapiro Wilk) lebih sensitif 

dibandingkan penilaian secara deskriptif (menghitung koefisien varians, rasio skewness, 

rasio kurtosis) 

b. Penilaian secara analitik lebih obyektif dibandingkan secara deskriptif (metode 

histogram dan plots) 
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Langkah melakukan uji normalitas dengan SPSS: 

➢ Buka data penelitian misal latihan SPSS 2 > Klik analyze > Descriptive statistics > 

Explore 

 
 

 

➢ Masukan variabel skala numerik yang akan di uji normalitasnya ke kotak dependent list. 

Masukan variabel skala kategorik ke factor list 

➢ Pilih both pada display > Aktifkan kotak plots 
 

➢ Aktifkan factors level togheter pada boxplots (untuk menampilkan boxplot), aktifkan 

histogram (untuk menampilkan histogram) dan normality plots with test (untuk 

menampilkan plot dan uji normalitas) 

➢ Klik continue > Klik OK 
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➢ Akan muncul jendela output sebagai berikut 
 

 

6.3 Uji T Tidak Berpasangan 

Uji T tidak berpasangan (independent) adalah statistik parametrik yang dipergunakan 

untuk membandingkan dua nilai rata-rata sampel yang tidak saling berpasangan (bebas). 

Tabel 4.2. Syarat uji T tidak berpasangan 
 

Syarat Jawaban 

Variabel yang dihubungkan Kategorik dengan numerik 

Jenis hipotesis Komparatif 

Pasangan/Tidak Tidak Berpasangan 

Jumlah kelompok 2 kelompok 

Distribusi/ sebaran data Normal (Wajib) 

Varians data Boleh sama, boleh tidak 

 

➢ Jika memenuhi syarat tersebut, maka uji yang digunakan adalah uji t tidak berpasangan 

(uji parametrik). 

➢ Jika tidak memenuhi syarat, maka digunakan uji alternatifnya yaitu Mann-Whitney (uji 

non-parametrik) 
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Tabel 4.3. Interpretasi dalam Uji Varian, Uji T dan Uji Mann Whitney 
 

No Nama Uji Makna jika p < 0,05 

1 Uji Varians Leuvene Sebaran data  yang  dibandingkan  mempunyai 

varians yang berbeda (heterogen) 

2 Uji T Tidak Berpasangan Terdapat perbedaan rerata yang bermakna antara 

dua kelompok 3 Uji Mann Whitney 

 

Berikut adalah langkah melakukan Uji T tidak berpasangan dengan SPSS: 

➢ Buka latihan SPSS 2 

➢ Klik analyze > Compare means > Independent sample t 
 

 

➢ Masukan variabel berskala numerik ke dalam kotak test variable. Masukan variabel 

berskala kategorik ke dalam grouping variable 
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➢ Aktifkan kotak define group 

➢ Masukan angka 1 untuk kotak group 1 (sebagai kode kelelahan mata). Masukan angka 

2 untuk kotak group 2 (sebagai kode sehat) 

➢ Klik continue > OK 
 

 

➢ Akan mucul jendela output sebagai berikut 
 

 

6.4 Uji Mann Whitney 

Mann Whitney U Test adalah uji non parametris yang digunakan untuk mengetahui 

perbedaan median 2 kelompok bebas apabila skala data variabel terikatnya adalah ordinal atau 

interval/ratio tetapi tidak berdistribusi normal. Digunakan jika data yang kita uji tidak 

memenuhi syarat Uji T Tidak Berpasangan (uji parametrik). 

Berikut adalah langkah melakukan Uji Mann Whitney dengan SPSS: 

➢ Buka latihan SPSS 2 

➢ Klik analyze > Non parametrics test > Legacy dialogs > 2 independent samples 



42  

 

 

➢ Masukan lama istirahat ke kotak test variabel list. Masukan hasil RT ke grouping varible 

➢ Aktifkan uji Mann Whitney 

➢ Klik Kotak define group 
 

➢ Masukan angka 1 untuk kotak group 1 (sebagai kode kelelahan mata). Masukan angka 

2 untuk kotak group 2 (sebagai kode sehat) 

➢ Klik continue > OK 
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➢ Akan muncul output sebagai berikut: 

 

 

 

6.5 Uji Anova 

Anova adalah sebuah analisis statistik yang menguji perbedaan rerata antar grup. 

Digunakan jika data yang kita uji tidak memenuhi syarat Uji One Way Anova (uji parametrik). 

Tabel 4.4. Syarat Uji Anova 
 

Syarat Jawaban 

Variabel yang dihubungkan Kategorik dengan numerik 

Jenis hipotesis Komparatif 

Pasangan/Tidak Tidak Berpasangan 

Jumlah kelompok 3 kelompok 

Distribusi/ sebaran data Normal (Wajib) 

Varians data Sama atau homogen (Wajib) 

 

➢ Jika memenuhi syarat tersebut, maka uji yang digunakan adalah uji one way Anova 

➢ Jika tidak memenuhi syarat, maka digunakan uji alternatifnya yaitu Kruskal-Wallis (uji 

non-parametrik) 
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Gambar Alur Uji Anova dan Kruskal Wallis 

 

 

Berikut adalah langkah melakukan Uji Anova dengan SPSS: 

➢ Buka latihan SPSS 2 

➢ Analyze > Compare means > One way Anova 
 

 

➢ Masukan variabel lama penggunaan komputer ke kotak dependent list. Masukan 

variabel lelah kategorik ke kotak factor list 

P <0.05 

Sama ANOVA 

ANALISIS 
POST HOC : 

BONFERRONI 

P > 0.05 

Normal UJI VARIANS 

P <0.05 
ANALISIS 

POST HOC : 
TAMHANE’S 

Beda ANOVA 
UJI NORMALITAS 

P > 0.05 

P <0.05 

Tidak Normal 
UJI 

KRUSKAL 
WALLIS 

ANALISIS POST 
HOC : MANN 

WHITNEY 

P > 0.05 
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➢ Aktifkan kotak options > Pilih homogeneity of variance > Klik continue > Klik OK 
 

 

➢ Akan keluar jendela output berikut, dari tabel test of homogenity of variances diketahui: 

Interpretasi: Significancy test homogeneity of variances = 0.724 (p>0.05). Maka tidak 

ada perbedaan varians antara kelompok data yang dibandingkan (varians sama). 
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Dari tabel Anova diketahui p= 0.000 (P < 0.05) artiya “paling tidak terdapat perbedaan 

lama penggunaan komputer pada dua kelompok”. Untuk melihat kelompok bermakna, 

maka dilakukan analisis post hoc. 

➢ Analyze > Compare means > One way anova 
 

 

➢ Masukan variabel lama penggunaan komputer ke kotak dependent list. Masukan 

variabel lelah kategorik ke kotak factor list 

 
 

 

➢ Aktifkan kotak post hoc > Pilih Bonferroni > Klik continue > Klik OK 
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➢ Akan muncul jendela output post hoc berikut 
 

 

 

6.6 Uji Kruskal Wallis 

Uji Kruskal-Wallis adalah salah satu uji statistik non parametrik yang dapat digunakan 

untuk menguji apakah ada perbedaan yang signifikan antara kelompok variabel independen 

dengan variabel dependennya. Merupakan uji alternatif jika tidak memenuhi syarat uji Anova. 

 

Berikut adalah langkah melakukan Uji Kruskal Wallis dengan SPSS: 

➢ Buka latihan SPSS 2 

➢ Klik Analyze > Non parametric tests > Legacy Dialogs > K-independent samples 
 

➢ Aktifkan uji Kruskal Wallis 

➢ Masukan variabel lama istirahat ke kotak test variabel list. Masukan lelah kategorik ke 

kotak grouping variable. Kemudian klik define range. 
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➢ Masukan angka 1 untuk kotak minimum. Masukan angka 3 untuk kotak maximum 

➢ Klik continue > OK 
 

 

➢ Akan keluar jendela output sebagai berikut 

 

 

 

• Untuk mengetahui kelompok yang berbeda, maka perlu dilakukan analisis post hoc 

Mann Whitney (Lihat materi 4.4. Uji Mann Whitney) 
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6.7 Uji Chi Square dan Uji Fisher Exact 

Chi Square disebut juga dengan Kai Kuadrat. Chi Square adalah salah satu jenis uji 

komparatif non parametris yang dilakukan pada dua variabel, di mana skala data kedua variabel 

adalah nominal. 

Uji Fisher adalah uji statistika nonparametrik yang digunakan untuk menguji 2 sample 

independen atau untuk mengetahui ada tidaknya hubungan antara 2 variabel yang berskala 

nominal atau ordinal. Uji Fisher ini memiliki tujuan yang sama dengan uji Chi Square karena 

merupakan alternatif dari uji Chi Square 2 x 2 ketika uji Chi-Square tidak memenuhi syarat 

untuk digunakan misalnya nilai Expectation di Chi-Square lebih dari 20% (tidak ada nilai 

expectasi tabel <5%, jika menggunakan tabel 2×2). 

 

Tabel 4.5. Syarat Uji Chi Square 
 

Syarat Jawaban 

Variabel yang dihubungkan Kategorik dengan kategorik 

Jenis hipotesis Komparatif 

Pasangan/Tidak Tidak Berpasangan 

Jenis tabel B x K 2 x 2 

 

Berikut cara melakukan uji chi square dengan SPSS 

➢ Bula latihan SPSS 2 

➢ Klik analyze > Descriptive statistics > Crosstabs 
 

 

➢ Masukan variabel bebas ke dalam row. Masukan variabel terikat ke dalam column 

➢ Klik kotak statistics 
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➢ Pilih chi square > Pilih risk > klik continue 
 

➢ Aktifkan kotak cell. Pada kotak counts, pilih observed dan pilih expected 

➢ Klik Continue > OK 
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➢ Akan muncul jendela output sebagai berikut 
 

 

 

 

➢ Jika nilai expected > 20% maka tidak memenuhi syarat sehingga yang dilihat baris 

Fisher Exact Test. Namun jika < 20% maka memenuhi syarat, yang dilihat continuity 

corection jika tabel berupa 2x2, jika selain tabel 2x2 maka dilihat pearson chi square. 

➢ Untuk melihat kekuatan hubungan dapat dilihat pada output tabel risk estimates 
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6.8 Uji Korelasi Pearson dan Uji Korelasi Spearman 

Uji korelasi merupakan teknik analisis yang digunakan untuk mengetahui ada tidaknya 

hubungan antar 2 variabel yang diuji. 

Tabel 4.6. Syarat Uji Korelasi Pearson 
 

Syarat Jawaban 

Variabel yang dihubungkan Numerik dengan numerik 

Jenis hipotesis Korelatif 

Analisis • normal dan syarat linearitas terpenuhi → uji 

korelasi Pearson 

• Bila kedua variabel tidak normal dan syarat 

lineartias terpenuhi → uji korelasi Spearman 

• Bila syarat linearitas  tidak terpenuhi, 

JANGAN lakukan uji korelasi  → uji 

komparatif 

 

Berikut adalah langkah melakukan uji korelasi: 

➢ Buka latihan SPSS 2 

➢ Lakukan uji normalitas (lihat materi 4.1. Uji Normalitas) 

➢ Lakukan uji linearitas sebagai berikut: 

➢ Klik analyze > Compare means > Means 
 

➢ Masukkan hasil reaction ke dependen list, umur responden ke independent list 
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➢ Klik options. Pada kotak statistics for first layer pilih test for linearity 

➢ Klik continue > OK 
 

 

➢ Akan muncul jendela output sebagai berikut 
 

 

 

➢ Jika syarat normalitas dan linearitas terpenuhi, baru lakukan uji korelasi pearson 

➢ Klik analyze > Correlate > Bivariate 
 

 

➢ Masukkan umur responden dan hasil reaction time ke dalam kotak variables 

➢ Pilih uji pearson pada kotak correlation coefficients. Jika syarat uji pearson tidak 

terpenuhi maka gunakan uji korelasi spearman dengan ceklis pada bagian spearman. 
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➢ Pilih two tailed pada test of significance bila hipotesis dua arah > klik OK 

➢ Akan muncul jendela output sebagai berikut 
 

 

 

 

Rangkuman 

✓ Statistik inferensial yaitu metode yang berhubungan dengan analisis data pada sampel 

dan hasilnya digunakan untuk generalisasi terhadap populasi 

✓ Uji Normalitas adalah sebuah uji yang dilakukan dengan tujuan untuk menilai sebaran 

data pada sebuah kelompok data atau variabel 

✓ Uji T tidak berpasangan (independent) adalah statistik parametrik yang dipergunakan 

untuk membandingkan dua nilai rata-rata sampel yang tidak saling berpasangan (bebas). 
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✓ Mann Whitney U Test adalah uji non parametris yang digunakan untuk mengetahui 

perbedaan median 2 kelompok bebas apabila skala data variabel terikatnya adalah 

ordinal atau interval/ratio tetapi tidak berdistribusi normal. 

✓ Anova adalah sebuah analisis statistik yang menguji perbedaan rerata antar grup. 

Digunakan jika data yang kita uji tidak memenuhi syarat Uji One Way Anova (uji 

parametrik). 

✓ Uji Kruskal-Wallis adalah salah satu uji statistik non parametrik yang dapat digunakan 

untuk menguji apakah ada perbedaan yang signifikan antara kelompok variabel 

independen dengan variabel dependennya. 

✓ Chi Square adalah salah satu jenis uji komparatif non parametris yang dilakukan pada 

dua variabel, di mana skala data kedua variabel adalah nominal. 

✓ Uji korelasi merupakan teknik analisis yang digunakan untuk mengetahui ada tidaknya 

hubungan antar 2 variabel yang diuji. 

 

Evaluasi Formatif 

6.8.1 Lakukanlah analisis untuk setiap uji di atas ! 

6.8.2 Interpretasikan hasil analisis dari setiap uji di atas! 
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BAB VII 

UJI VALIDITAS DAN RELIABILITAS 

 

 

7.1 Uji Validitas 

Uji validitas adalah uji yang digunakan untuk menunjukkan sejauh mana alat ukur yang 

digunakan dalam suatu mengukur apa yang diukur. Uji validitas digunakan untuk mengukur 

sah, atau valid tidaknya suatu kuesioner. Suatu instrumen yang valid akan mempunyai validitas 

yang tinggi, sebaliknya instrumen (kuesioner) yang kurang valid berarti memiliki validitas yang 

rendah. 

Uji validitas dapat diukur dengan beberapa uji, beberapa diantaranya adalah 

1. Bivariate pearson 

2. Corrected item total correlation 

3. Confirmatory Factor Analysis (CFA) 

Pada modul ini hanya akan membahas bivariate pearson dan corrected item total 

corellation. Berikut adalah langkah untuk uji korelasi dengan bivariate pearson, untuk uji 

corrected item total corellation akan dibahas pada bagian uji reliabilitas. Sebuah item kuesioner 

dianggap valid jika r hitung > r tabel. 

 

➢ Buka latihan soal validitas dan reliabilitas 

➢ Klik Analyze > Correlate > Bivariate 
 

 

➢ Masukan pertanyaan 1 s/d pertanyaan 10 dan total nilai ke dalam kotak variables 

➢ Pilih pearson pada kotak correlation coefficients 

➢ Pada kotak test of significance klik two tailed > Klik OK 
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➢ Akan muncul jendela output validitas bicariate pearson, bandingkan nilai r hasil dengan 

r tabel 

 
 

 

7.2 Uji Reliabilitas 

Uji reliabilitas adalah sejauh mana hasil pengukuran dengan menggunakan objek yang 

sama, akan menghasilkan data yang sama atau untuk mengetahui konsistensi alat ukur, apakah 

alat pengukur yang digunakan dapat diandalkan dan tetap konsisten jika pengukuran tersebut 

diulang. Dalam program SPSS metode yang sering digunakan adalah dengan menggunakan 

motode Alpha Cronbach’s. 
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Kategori koefieisn reliabilitas menurut Guilford (1956) 

Reliabilitas sangat tinggi 0,80 – 1,00 

Reliabilitas tinggi 0,60 – 0,79 

Reliabilitas sedang 0,40 – 0,59 

Reliabilitas rendah 0,20 – 0,39 

 

 

Berikut cara melakukan uji reliabilitas Alpha Cronbach’s dengan SPSS 

➢ Buka latihan soal validitas dan reliabilitas 

➢ Klik Analyze > Scale > Reliability test 
 

➢ Masukan item yang valid ke kotak items, total nilai tidak perlu dimasukan > Klik OK 
 

➢ Akan muncul jendela output sebagai berikut 
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Berikut langkah melakukan uji validitas dan reliabilitas dengan Uji Validitas Corrected 

item – Total correlation 

➢ Buka latihan soal validitas dan reliabilitas 

➢ Klik Analyze > Scale > Reliability test 
 

➢ Masukan pertanyaan 1 s/d pertanyaan 10 ke dalam kotak items (tanpa total nilai) 
 

➢ Klik kotak statistics > Centang scale if item deleted pada descriptive for > Klik continue 

> OK 
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➢ Akan muncul jendela output sebagai berikut 

 

 

 

➢ Hasil dinyatakan valid jika hasil pada kolom corrected item total correlation > r tabel. 

Nilai Alpha Cronbach menunjukkan nilai reliabilitas. Nilai ini bisa diterima jika semua 

item pertanyaan valid. Jika ada item yang tidak valid, maka harus dilakukan uji ulang 

dengan membuang item pertanyaan yang tidak valid 

➢ Melakukan uji ulang karena ada pertanyaan tidak valid, dengan membuang item 

pertanyaan tersebut 

 

➢ Jendela output setelah uji ulang, semua item valid dan nilai reliabilitas dapat diterima 
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Rangkuman 

✓ Uji validitas adalah uji yang digunakan untuk menunjukkan sejauh mana alat ukur yang 

digunakan dalam suatu mengukur apa yang diukur 

✓ Uji reliabilitas adalah sejauh mana hasil pengukuran dengan menggunakan objek yang 

sama, bertujuan melihat konsistensi instrumen. 

 

Evaluasi Formatif 

7.2.1 Lakukan uji validitas dan reliabilitas dengan menggunakan data pada format 

spv yang telah diberikan. 

7.2.2 Interpretasikan dari setiap uji validitas dan reliabilitas tersebut. 

7.2.3 Bandingkan perbedaan nilai untuk setiap uji validitas. 


